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Getting Started

First you need to create a new Home Budget database. To do so, simply select the File Menu and Pick 
New. Then enter the name of the database (with no extension).

Once created you need to Add Accounts using the Setup Accounts under the Setup menu. Once the 
accounts are created you can define a budget using the Budget setup also under the Setup menu.

A sample database is included with Home Budget called “Sample” you can select this database using the 
File Open command and have a look at a typical setup. Even try out the Graph module on the database.

For more information on setting up accounts see Setting up Accounts



Home Budget Summary
Home    Budget finance program    is based around the tradition envelop style budgeting system. It allows 
you to set aside at regular or non regular intervals, a portion of your funds. It has no real concept of 
monthly or weekly time frames, but allows complete flexibility of budgeting or analyzing results during any 
given time period.

Basically you create accounts of either real source funds (such    as BANK account or CHECKING 
account), or expense accounts    that    allocate    a    portion    of    the    funds (i.e. UTILITIES, GROCERIES
and    so    on...).    

This method easily gives you the ability to set aside a portion of your income each (month/week/year) for 
different    expenses. For example you may budget $100 a month for    UTILITIES, since that is the 
average amount spent, or you may put $200 a month away for a holiday being planned for 10    months 
away for which the cost is expected to be $2,000. This way when the money is needed it will be available.

This design gives Home Budget a real advantage over many commercial financial packages that miss the
basic budget and save design that Home Budget uses.

With each transaction entered TWO accounts are involved. The    first    is the current account being    
displayed,    the other is called the 'SOURCE ACCOUNT' (displayed under the 'Account' column of    the 
transaction) and is entered as the transaction is typed in.

Conveniently    you    can    be in either account to enter the transaction. If    for    example you had bought a
$100 in groceries    using        a        Check,    you    could    enter    this transaction    from    your    
GROCERIES    expense    account    and record the 'SOURCE ACCOUNT'    as    Check or enter in under 
the CHECK account and record    the    'SOURCE    ACCOUNT'    as GROCERIES.    In either case one    
transaction    is    recorded.

In order to    start    using Home Budget you must first Create a Home Budget Database using the File -
menu and Select New, enter a name ie Budget and click Open. See Getting Started for more information. 

Once you have created the database you must add some accounts. To do so, select the 'Setup Accounts' 
function from the Setup menu. Choose the 'Add' function. See Setting up Accounts for more information.



New Features for Version 3.0

· Few Minor bug fixes

· Limited Undo feature.

· Undo Last Budget transactions.

· New Search Window, allows searching all accounts and display results in new window, with printing, 
deleting, reconciling the resulting transactions

· New optionally displayable Flag Field.. A user definable 1 character field can be used for sub 
categorizing transactions.

· Able to use HB date format, or windows regional setting for date format and currency symbol.(not 
available in Win 3.1 version)

· New Import transactions feature. (From QIF format)

· Export transactions to QIF or comma delimited format

· Right Mouse button support

· Move Transaction function

· Autopayment Confirm dialog allows modifying AutoPayments as they are created.

· Uninstall support (Win 95/NT only)

· Find is now bound to CTRL-F

· Optional Automatic Autopayment creation on startup.

· Average debit display in Budget setup

        
 



Why Use Home Budget?

Home Budget does not try to overwhelm you with so many features that just end up filling your hard drive 
and over complicate the program. Instead it uses a simple, envelope style budgeting system taught by 
many home financial planning consultants.

Simply put, by dividing your spending into categories of expense (Expense Accounts) and allocating 
(Budgeting) a portion of your income to each one, you can not only track your spending but continue to 
save for future planned expenses. It’s like having an unlimited number of bank accounts each with its own
purpose.

Features of Home Budget include a very fast and easy to use data entry system where each transaction 
is just one line and everything is point and click.

Notable features include:
Automatic Payment Transactions
Easy one line data entry
Visual Graphs
Reporting, summaries, networth, transactions
Reconcile using search and click
Adjustable date range view into database
Windows 95 32 bit version or Windows 3.1 version available
Fast and reliable (written in C++).



Tool Bar 

Buttons in order:
Add / Delete Transaction
Reconcile / Unreconcile Transaction
Find / Find Next
Prev Account / Goto Account / Next Account

Print
Account book window
Account summary window
Networth window
Chart window
Calculator
From/To Range buttons

Tip: Many of the Tool bar & Menu    functions are available using the “Right” mouse button. For example 
using the right mouse button over a selected transaction will allow you to delete, move, reconcile that 
transaction.



Setting up Accounts
To add a new Account, click the Add button. To modify an existing account you can double click on the 
account or click the modify button.

Explanation of account fields
Account Name

Each account must have a unique name. It is best to keep them unique within the first 5-8 characters, as 
this will save extra typing later.

Date Open

Since Home Budget allows complete control over reporting and allows a view of your budget for any 
given period of time, it must know when accounts were created.

The Date Open field should contain a date previous to the first transaction that is planned to be 
entered into this account. If you set this date to    01-JAN-98, you will not be able to enter a transaction 
against this account for any date previous to 01-JAN-98. Also any reporting done for a date range 
previous to 01-JAN-98 would know to leave this account absent from any displays or reports. (As with 
any fields, this date can modified later if entered incorrectly).

Account Type

Bank Use for any real bank/savings account. Holds real funds.
Checking A Checking account. Tracks Check numbers used. Holds real funds.
Income Create at least one of these accounts to record your income. It is used as a door into your

Bank or Checking type accounts, while at the same time recording in one place, all 
income.

Expense These are the accounts used to allocate and record transactions for various expenses 
(categories). For example: Groceries, Utilities, Mortgage and so on. The number of these 
accounts you create will depend on how much detail you wish to setup your budgeting 
and reporting. The EXPENSE accounts are the accounts that will also show up later 
under the BUDGET SETUP where you will determine how much money each EXPENSE 
account should be allocated.

Asset Asset accounts are used if you wish to track investments or Funds that are not part of 
your cash flow. For example, RRSPs, Stocks, Property. These account balances are not 
counted into the general Income or Cash flow totals, but are listed at the bottom of the 
NetWorth window and are included into your Total NetWorth. See Tracking Assets for 
more information.

Credit Card Create one of these for each Credit card you use. Then any items purchased via a credit 
card can be recorded as such. This account becomes credited, by each debit from an 
EXPENSE account when entered as a credit card purchase thereby reserving the funds 
necessary to meet the inevitable credit card bill that will follow. The credit card bill then is 
entered against this account as a debit. In other words, you end up moving your money 
over to this account as you purchase items with a credit card. Then when the credit card 
bill arrives, the money is sitting in this account, ready to pay the bill.

TIP: It is very convenient to organize all your credit card bills together, then, go to the 
credit card and then enter all the bills within this account. Note: Doing it this way you will 
need to enter each purchase as a credit to the credit card account, which then would 
debit the associated expense account.

Reconcile

Enable this if you wish each transaction entered against this account to be initially unreconciled. A ‘*’' 
will be displayed at the right of transaction. This also affects the Rec Bal field on the account totals, 



which displays only the totals of the transactions that are reconciled. See Account Totals for more 
information.

Starting Bal

Set this field to the amount of    the opening balance of the account. If it is a real BANK/CHECK 
account this will be obvious. For EXPENSE accounts you may wish to just divide your current funds up
to allocate a starting amount to each account. INCOME accounts would typically start at zero, but any   
amount entered to the initial balance of these accounts has no effects on other accounts.

Date Closed

As with the OPEN DATE the Date Closed field allows for a clear picture of the budget for any given 
time period. If you had created say a short-term expense account to allocate some funds, then later 
finished with that account, you cannot actually delete it, if it has transactions recorded against it. 
Instead you close it using this field. Then any time the date range is set to start after this closed date, 
this account will be hidden from view. Yet if you set the date range back to when this account was 
active, you will again be able to view the past transactions for this account.

To close an account the Ending balance must be Zero. If it is not, create an entry to either debit/credit it
to balance it to zero, using another account or using the special    'BUDGET' account name.



Setting up Budgets
In Home Budget, budget amounts are transferred into the various expense accounts each time you 
perform the    ‘Do budget’ function. Typically this is done monthly or bimonthly depending on your income 
interval. This actually results in a transaction being created against the EXPENSE account with 'BUDGET'
specified as the source account.    In other words you have Allocated or transferred funds for each specific
expense account.

To enter a budget amount, highlight the desired account and click modify, or just double click on the 
account. Then enter the new amount.

At the bottom of the display the total Budgeted amount is displayed as well as the remaining balance.

The remaining balance shows the amount of unallocated funds that will remain after creating the budget 
transactions.

If after creating the budget transactions you realize that an account needed more or less budget funds, 
you can go to that specific account and edit the BUDGET transaction that was just created.

Editing the budget amounts on the BUDGET setup screen only affects the amounts that will be allocated 
to each account when the next 'Do Budget Transactions' command is executed.

The UNDO function allows you to remove a previously executed set of BUDGET transactions.

The AVE column displays the average spent in each expense account. Click on the “Ave”    button on the 
top of the column to change the way the average values are displayed.



Budget Setup – Average Spent Parameters
The Average column amounts in the Budget Setup window can be adjusted via this dialog. Using the drop
down selection boxes you can choose how the average spent amounts are calculated. Ie Monthly, weekly,
bi-weekly and so on. The other drop down box controls how far back Home Budget looks for transactions 
to calculate the average.
.
Important: The from date on the main window is use to control the window of time that the average 
calculation is done. For example of the From date is currently set to blank (or Latest) and Period is set to 
1 year, then all transactions from the current date back 1 year are averaged. If the From date is currently 
set to 01-Dec-1997, then the average spent is calculated using all transactions between that date and 01-
Dec-1996.

The default is, 1 year back displayed as a monthly average. If you change these settings Home Budget 
will remember them as your new defaults.

Limit Based on Account Activity Check Box: This option will affect the average values, by only using the 
number of months (periods) back for each account that actually had transaction activity. For example if an
account had transactions created over the past three months, but the prior nine months had no activity, 
then the amount spent over the past three months would be divided by three instead of 12.



Setting up AutoPayments
AutoPayments are really just scheduled transactions. You can have these occur on a specific date, 
monthly, daily, weekly etc.

The transactions are not actually created until you select the “Do Auto Payment” button. This will then 
create all transactions that are due. You can select the “Confirm” box in the dialog that pops up to be 
prompted to confirm each transaction before it is created. That way you can skip by or postpone certain 
currently due transactions.

The AutoPayment dialog box displays each Schedule transaction. The Next Date column indicates the 
next due date of payment. A asterisk “*” will be displayed beside the date if the transaction is currently 
due.

The account column lists the owner of the transaction, this is the account for which the debit and credit 
are shown against. The From Account shows the source account from where the funds are being moved 
from.

To add an AutoPayment click on the Add button. To modify an existing AutoPayment click the modify 
button or double click on the desired transaction

See Adding or Modifying an AutoPayment for more information.



Adding or Modifying an AutoPayment
For adding or modifying an AutoPayment the following information is required:

Transaction Information

Account This is the owner account of the transaction. For example if this is Utilities, then the
debit/credit amount is against the Utilities account.

Payment Name A Description of the payment or scheduled transaction. For example “Electric Bill”. 
For AutoPayments a “(A)” is appended to the description to indicate it was created 
via the AutoPayment function.

Source Account The account from which the funds are being with drawn. For example if this is your 
Checking account then it will be debited by the amount of the Electric Bill (above).

Debit/Credit Amounts that are debited or credited from the Account.

Schedule Information

Next Payment Date Indicates the next payment date for this transaction. You must enter a valid 
date.

Occur Every Select either Months or Days. For Weeks, use 7 Days, or for Bi-Weekly use 14 
days and so on. For a monthly payment set the Next Payment date and then 
select 1 Month. This will produce a transaction on the same day every month.

Payments Remaining Only this number of transaction will be created. Each time this number will be 
decremented, and once at zero, no more transactions are created for this 
AutoPayment. Leave this blank for indefinite.

Next Check Num. If the Source Account is a Checking account, and you wrote post dated Checks
that were in order, you can enter the starting Check here, and it will be 
incremented and recorded against each transaction.

Confirm when transaction is created
Setting this flag will result in Home Budget prompting you with the autopayment
confirm dialog box when the transaction is about to be created. This allows you
to provide/modify the credit/debit values of the transaction before it is actually 
created.

Tip: For regular payments for which the amounts are not fixed, use the confirm option to allow you to 
modify the value as the transaction is being created.



Confirm AutoPayment
When confirming an autopayment you have the opportunity to modify or provide the debit/credit amounts, 
modify the accounts involved and the item description.

If you cancel the confirmation dialog box, this particular autopayment will not be created. However, the 
next time you run the autopayments you will again be prompted to create this transaction. In other words 
canceling the confirm dialog box only delays the creation of the autopayment. 

See also Adding or Modifying an AutoPayment.



Account Book Window
This window displays a particular Account, its Totals and transactions recorded against it. 

The default is to sort by date, however you can simply click on the title of each column to cause Home 
Budget to sort based on that item. Clicking again on the same column will reverse the sort order.

The Transactions and Totals displayed are directly related to the Date Range currently set. Any 
transactions that occur previous to the Range From date are not displayed as with any Transactions that 
occur after the Range To date. See Date Range Setting for information on changing the date range.

The various Totals are explained here:

Start Bal This is the starting balance for the account. This will be the amount entered when the 
Account was created if the from Range is set to Earliest. Other wise it displays the ending
balance for the date prior to the current From Range Date.

Budgeted The total amount Budgeted during the current date range. (May not be applicable to all 
accounts i.e. Bank or Check book for example)

Debit Total amount debited during the current date range.
Credit Total amount credited to this account during the current date range.
Rec. Bal The balance of the account using only the transactions that are reconciled (no asterisk). 

This may not be applicable to all accounts.
End Bal The ending balance. If the To Range is other than Latest this indicates the Balance up to 

that point in time.

Transactions can also be sorted by various criteria, by using the Sort option under the transaction 
menu.

Also, the right mouse button can be used to quickly perform certain operations on the selected 
transaction.

The View Menu also contains an option for displaying or hiding the optional Flag column.



Account Summary Window

This window displays all the Accounts (that are open during the current date range) along with the 
Account type, and all the totals. For an explanation of the various totals, see Account Book Window.

This window also allows you to sort the accounts by Name, Type and Budget amounts.

Double clicking on any account will bring forward the Account Book Window with that account selected.

Selecting Print will print these account summaries to the printer.



NetWorth Window

The NetWorth window is constantly updated to show your cash flow situation. Basically it summarizes the 
totals from your Bank and Checking accounts, the amount Allocated by the various expense and credit-
card accounts and the amount Remaining. It also displays your income accounts and total amount 
recorded as income for the current period.

The Amount Remaining is basically cash that you do not have allocated for any expense budget. 

If any expense accounts are over drawn or negative amounts, this is also displayed in the NetWorth 
window. The Amount Remaining has already been reduced by this amount to ensure that money is 
reserved for the potential of needing to cover even these overdrawn expense accounts.
This calculation of overdrawn expense accounts will be ignored if you have checked the ignore 
overexpensed in the options setup.

Any Asset account information are also displayed in the networth window, the remaining balance plus 
your Assets account give you a total networth amount.

Select Print while the NetWorth Window is active, will print the NetWorth report to the printer.



Search Window

Using the File->Search function allows you to search all accounts for particular transactions and displays 
the results in a single Search Window. See the help on the Search Dialog for information on the search 
criteria.

You can reconcile, delete, and even print transactions that are displayed in the search window. If you 
double click on a transaction in the search window Home Budget will jump to the original transaction in 
the accounts window where you may perform any normal operations against the transaction.

Using the Transaction menu (or right mouse button) in this window you can also choose to hide (remove) 
transactions from the search results. This is useful in case you wish to print or display totals for only 
certain transactions.



Search Dialog

The search dialog allows you to search for transactions where the item field contains a particular text, or 
where the debit/credit amounts are within a specified range and even the ability to only find transactions 
that are reconciled or un-reconciled.

Use the File->Search or CTRL+S keys to activate the search dialog window.

By default all accounts are searched, however you can choose to only search Expense accounts or you 
can be more selective and highlight only the specific accounts you wish to search.

The more search items you specify the more selective the search will be. For example if you specify “abc”
the item field and “T” in the flag field, then only those transactions that meet both criteria will be displayed.

See the help on the Search Window

Tip: Leaving all search criteria blank will result in displaying ALL Transactions from All accounts in the 
Search Results window.



Working With Transactions

The following topics explain various ways of working with transactions:

Adding
Deleting
Moving
Sorting
Splitting
Reconciling
Searching for
Undo



Adding a Transaction

To Add a transaction, first you must be in the Account Book window, viewing the account you wish to add 
the transaction for. (See Moving around accounts for various ways of selecting the account to view in the 
account window.) Then you can start the Transaction add process by Choosing ADD under the 
Transaction menu, Clicking the Add button on the tool bar, or the Ctrl+A keyboard short cut.

After you have finished adding one or more transactions press “Escape” to exit Add mode.

The following information is required for each transaction:

Date This is the date that the transaction took place. You must enter the date format in DD-
MMM-YY form, or any of the abbreviated methods that are permitted in any date fields 
within Home Budget.

Item The description of the transaction.

Account The Source or From account. This is were the funds are taken, or transferred from. If you 
are currently recording a Check in your Checking account that was spent on Groceries, 
then the Source Account would be Groceries. You may use the Up/Down arrows to 
search for the account, or press the first letter of the account and the list will be moved to 
that position, or you can click on the arrow to drop down the list of available accounts. 
The account you choose must be different from the current account, and must of been 
open during this transaction date.

                  Note: Entering SPLIT as the source account indicates that this transaction should be 
split into various parts, each part being recorded as a separate transaction. Against this 
transaction (first) you enter the total amount of the Transaction, after hitting return you 
then proceed to enter each split member of this transaction until the you have reached 
the total amount entered in the Split Owner. To split an existing Transaction see Splitting 
a Transaction.

Num This is the Check number field. It is used for transactions written against a Checking type 
account it indicates the Check number. It is also used to indicate a member of a split 
transaction. The Check number field is optional, it will default to the previous Check 
number entered plus 1. To leave the Check field blank (and not affect the last Check 
number remembered hit space key to blank the field and then TAB to advance to the next
field).

Flag (F) This is an optional field. By default this column is not displayed. To enable this field use 
the View menu in the Account Book window. When displayed this is a single character 
field that can be set to any value. You can use it to flag fields for reporting later. For 
example you could use “T” for any purchase that is a business Tax expense. Later you 
can use the Search Function to find all transactions with a Flag field equal to “T”.

Debit/Credit Amount debited or Credited to the currently viewed account. The Source account will also
be debited/credited the same amount. (If the source account was a Credit card account 
or if both accounts involved are the same type i.e. both Bank or both Expense, then the 
debit credit amounts are reversed for the Source account)
When adding a transacition paid by credit card while under the credit card account 
remember you have to add the amount spent as a credit to the credit card account. See 
Setting up Accounts for more information on Credit card accounts.



Deleting a Transaction

Simply highlight the desired transaction and then choose Delete from the Transaction window, or press 
the Delete key. You will be asked to confirm the action.

If you delete a split member transaction, its amount is moved to one of the other remaining split members.
If there are no other split members the transaction is turned back into a regular (non-split) transaction. If 
you delete a SPLIT owner transaction it and all the split members are also deleted.



Moving a Transaction

Moving a transaction, allows you to remove it from the current account and re-create it in another 
account, keeping all the same attributes.

For example if you were currently in your “Visa” account and enter a transaction that was really paid by 
“Amex” you can use this function to move it to the correct account. The other account involved (for 
example Grocery expense account) would not change.

To move, simply highlight the desired transaction and then choose Move from the Transaction window, or 
use the right mouse button menu. You will then be prompted for the account name.



Sorting Transactions

Under the Transaction Menu you may sort via different methods. Note that when the transactions are 
sorted, the Balance column tracks the balance for the order of the transaction displayed and may not be 
too helpful if the account is not sorted by date.



Splitting a Transaction

To enter a split transaction you simply enter the Source Account as SPLIT. To turn an existing Transaction
into a SPLIT owner transaction can either choose Split from the Transaction menu or Click on the Source 
Account field of the transaction and change it to Split. In either case you will be placed in Transaction Add 
mode and will need to add Split members to the account until you have totaled the amount entered in the 
owner transaction. Note that all Split transactions are force to have the same date.

If you delete a split member transaction, its amount is moved to one of the other remaining split members.
If there are no other split members the transaction is turned back into a regular (non-split) transaction. 

If you delete a SPLIT owner transaction it and all the split members are also deleted.



Reconciling

Click the Reconcile button on the tool bar, choose the Reconcile choice in the Transaction menu or the 
Ctrl+R short cut; to reconcile the currently selected transaction.

You can reverse this by using the Unreconcile function.

Double clicking on the Reconcile column will also Toggle the Reconcile flag.



UnReconciling

Click the UnReconcile button on the tool bar, choose the UnReconcile choice in the Transaction menu or 
the Ctrl+U short cut; to unreconcile the currently selected transaction.

Double clicking on the Reconcile column will also Toggle the Reconcile flag.



Find

There are two ways to search for transactions using the “Find” operation, which searches the current 
account, or the global Search operation under the File menu that searches one or more accounts.

For the Find operation select the Find button on the tool-bar, the Find choice under the transaction menu 
or the Ctrl+F key to open the find dialog. You can then enter the text to search on. This can included any 
part of the transaction, i.e. Item description, amount debit etc. If found, this will become the currently 
selected transaction.

For the global Search operation see the help on the Search Function
For a convenient way to reconcile credit card statements or Check books using the Find command see 
Reconciling Bank Statements



Flag Field
This is an optional field. By default this column is not displayed. 

To enable this field, use the View menu in the Account Book window.

When displayed this is a single character field that can be set to any value. You can use it to flag fields 
for reporting later. For example you could use “T” for any purchase that is a business Tax expense. 
Later you can use the Search Function to find all transactions with a Flag field equal to “T”.



Undo

The Undo operation under the Edit menu allows Undo’ing the last modify, or delete operation performed 
on a transaction.



Moving around Accounts

There are different ways that you can jump to different accounts. You can use the Goto account button on
the tool-bar, you can double click on the desired account in the account summary window, or use the 
shortcut Ctrl-G key from any window within Home Budget.

When viewing an account in the Account Book, you can use Shift Right arrow or Shift Left Arrow to move 
to the next or previous accounts. The accounts are sorted alphabetically.



Date Range

To Change the Date Range click on one of the Two buttons on the right side of the Tool Bar, select Date 
Range from the Account menu, or use the shortcut Ctrl+D key.

Home Budget provides the concept of a window into your finances, where only transactions created 
during the given date range are displayed. This removes a lot of the clutter when all you are    interested in
is for example the last couple of months.

The totals displayed for each account are also affected by the date range. The Starting balance is always 
the ending balance for the period prior to the new From Range date. The debit / credit amounts show 
totals for the transactions created during the currently selected date range. 

This also becomes useful as you can set the range for example to be January to December for the 
previous year, goto any account or the account summary window, and immediately get totals of 
spending/budgeting/income etc. for that given year. These totals can then help you fine tune your budgets
for the next year.

When starting Home Budget it will set the To range to blank (Latest) and set the From range to the 
number of months back as specified under the Options settings.



Printing

Any window can be printed from within Home Budget by first ensuring the desired window is active, and 
then selecting Print from the file menu. You can also select Print Preview which will show you an exact 
representation of the printed page for your specific should you choose to print.

If for example you wish to print all transactions for the past 12 months for your Groceries account, first 
goto the Groceries account under the account book, set the date range goto back 12 months, and then 
select print.

You can also use the Account Summary window for example to just show the Expense accounts and their
Balances (using the Account Menu functions) and then just select print.

You can also select landscape printing to print on the long edge of the page if you are finding that some 
columns are truncated.



Generating Graphs and Charts

Home Budget has very flexible and convenient Chart generating interface. It can report against all 
accounts, just income accounts, just expense accounts or any specific account.

It has it’s own date range controls so as not to affect your current settings under the account book 
window.

Click on the window icon, or select the Graphs window under the Window menu.

You can size the chart window to any size and the charts will be rescaled to fit. When printing, the 
maximum size that will fit the paper is used. Also for some graphs you may even get better results by first 
selecting landscape mode under Print Setup.

To set the parameters for the graph click on the Set Parameters button. To change the type of graph 
shown you can click on the graph type display shown beside this button.



Setting Chart Parameters

Graphs consist of data elements represented in Rows and Columns. Normally Columns are represented 
Left to Right along the bottom (X axis) whereas Rows are show as depth (Z axis). The Y axis, or up/down 
left part of the Graph usually displays the number (amount).

Controls:

Dates
You can use the Quick drop down Dates selection to quickly set to the standard reporting dates, or 
enter your own custom dates in the From / To fields.
From All transactions or accounts created since this date are selected.
To All transactions occurring up to and including this date are selected.

Columns:
Expense All Expense accounts are listed along the bottom
Income All Income accounts are listed long the bottom
Month Each month is reported along the bottom.
Years Totals by year. Years listed along the bottom.

Rows:
Total Only Total Spent or Budgeted for All or a Specific Account for either entire period or by 

month, depending or column setting.
Budget vs Actual For all expense accounts, or a specific expense account this shows the Amount 

Budgeted vs the Amount Spent for either each year or month.
Income vs Budget For each month/year provides a summary of how your income compared to the 

total amount budgeted. The column setting must be set to either Months or 
Years.

Months Each row point represents a different month. Column must be set to either 
Expense or Income. Which means along the bottom of the graph will be either 
income or expense accounts and there will be multiple Row points per account to
represent the amount spent or budgeted for each month for that specific account.

Years As above except the Row values are divided up into Years rather than months. If 
displaying more that two years worth of data in this format, the months display 
can be rather cramped the by Year Row display maybe better in this case.

Income Accounts The column display must be either Months or Years, and this Row display will 
divide the Amount of Income for each income account per each Month or Year 
selected within the date range.

Expense Accounts Shows either total Budgeted or Total Spent (depending on expense type setting) 
for each month or year.

Ending Balance Displays the ending balance for the specific account at the end of each month, or
year. The column selection must either be set to, Months or Years. You must also
select a specific account, it cannot be set to “all accounts”.

Expense Type (for expense accounts only)
Budget Amount Budgeted for the period.
Spent Amount Spent (Debit - Credit) for the period.

Tips: 
If the Row type is set to Months displaying more than 2 years of data may cramp the display if you 
have many accounts. Try viewing by Years instead.
If you wish to Graph just One particular Expense Account you must set the Row selection to either 



Total only or Budget vs Actual.



Importing Transactions

This operation will allow you to import a standard QIF (quicken interchange format) file. A QIF file is a 
standard format produced by many popular financial applications. 

To import transactions from another application, use the File->Import function and follow the instructions 
below:

· Under the Import dialog, select the Date format used in the QIF file. (Unfortunately some applications 
write this as DD/MM/YY while other use MM/DD/YY and yet others use a user-defined format). You 
may need to view this QIF file with notepad to determine the date format being used in the file.

· Choose the option “Ignore Subcatagories” if you wish each main sub category of expense under the 
previous application to map to a single expense account under Home Budget. For example an 
account called Entertainment:Movies and Entertainment:Skiing would both map to an account called 
“Entertainment”. This is the preferred method.

· Select Prevent Duplicate transactions if you are possibly importing more than one QIF file (so more 
than one account) and there may be transfer transactions moving money between the two accounts. 
This prevents the same transaction from being imported twice (once from each QIF file).

· Enter the name of the QIF file and press import.

Notes:

The Import operation cannot be undone. You should first, make a backup copy of your database in case 
any unforseen errors should occur.

During the import process you will be asked for a name and account type for the account being imported.

QIF Import Limitations

Home Budget does not support all the data provided in QIF files related to investment and asset 
accounts. Some of this information will be retained in the item description field but will not be used in the 
same way that investment applications use the data.



Exporting Transactions

Using Export under the File Menu will allow you to export all transactions from an account. The 
transactions selected for export are all those currently displayed, or in other words, all transactions 
selected by the current Date From/To range settings.

To Export Transactions:

· Select the export file type, either Comma delimited (Excel compatible) or QIF (Quicken interchange 
format).

· If you will be exporting transactions from more than one account you can check the option “Only 
Export same Transaction from one account” this prevents a transaction from being exported under 
both accounts.

· Choose the account to export, by default this will be the account currently displayed under the 
accounts window.

· Choose a date format compatible with the application that you will be using the data with.
· Enter a file name and press Export button.



Optimizing the Database

This operation is only really needed when the Database seems slow to load or Sort. It cleans up the file, 
and rewrites it back in optimum sorted order. If for some reason the Optimize fails (i.e. out of disk space) 
the original files are saved as OLD.trn, OLD.acc and OLD.atp. You will need to use the FileManager to 
remove any partially created new files and rename these back to the original names.



Purging Old Transactions

If you wish you may remove transactions that you no longer need to view or report against out from the 
active database into archived files. You can later Merge them back in if you wish, or even use the    Open 
function under the file menu to treat them as a separate Home Budget Database which the exception that 
no modifications can be made to archived Databases.

Since Home Budget can load quickly even 10 years worth of data in only a few seconds, purging 
transactions is really only useful for machines with limited amount of memory (i.e. less than 4 Megabytes),
or to keep the finance program small enough so as to fit on a floppy disk.

To Merge you must supply a Date. All transactions previous to this supplied date are purged. Note that 
however, all transactions during this period must be reconciled. If Home Budget finds any transactions not
reconciled, it will let you know which account, and abort the purge until you have reconciled these 
transactions.

It is recommended that you first Backup your database before perform the Merge function.

Note: Currently the Archived files are written to the same location from where the budget files was loaded.
For safe keeping you may wish to move these to backup disks using the FileManager. The file 
names will be the first 6 characters of your budget name with the year (YY) appended followed by 
the extensions .TRN .ACC. ATP



Merging Archived Transactions

This function will merge back all Transactions starting with the specified year back into the active 
database. The files that are used are based on the budget name with the Year appended. For example if 
your budget name is BUDGET.trn then and you entered the Year 92. Then the files Budget92.* and 
Budget93.* and so on are used until all archived transactions have been merge back in.

It is recommended that you first Backup your database before perform the Merge function.

Note: Currently the Merge function checks the same location on your drive from where the Budget file 
was loaded. If the Archived files are in a different location, you must first move them into your 
budget directory with the FileManager.



Backing up the Database

It is a good idea for whenever you have finished entering any transactions into Home Budget to backup 
the database before exiting the program. If you like you can have Home Budget prompt you to perform 
the Backup each time you exit the program after making any modifications. See Setup Options for more 
information. 

The default location for the Backup is A:\budgetname.trn you can change this or click the browse button to
location



Setup Options

The follow options can be set:

From Range The number of months back to set the Date From range upon loading this database
in Home Budget. A zero in this field will set the From/To range included all dates.

Password This is optional. Set this to a password of 8 characters or less. You will not be able 
to access this budget without first entering this password. If you later wish to 
remove the password protection just blank this field.

AutoPayment Reminder 
This will remind you each time you load the Database, if any AutoPayments are 
due to be created. Select the Setup-AutoPayments function to view and execute 
the due AutoPayments.

AutoPayment Execute on Startup 
Any due autopayment transactions will be executed when the program starts.

Backup Prompt Checking this box will cause a Backup Prompt box to be displayed each time you 
exit the program and have made any modifications to the Database. This is 
recommended.

Ignore OverExpensed    
Normally Home Budget will account for expense accounts that are in the Red 
(overdrawn)    in the networth calculation for remaining balance. If you check this 
box, this changes the default behavior not to reserve funds from the remaining 
balance to cover the overdrawn amount(s).

Use Windows settings for Date and Currency format 
This enables the use of the windows defined format for short dates and the 
currency symbol.
When this box is not checked, then the Home Budget default date format of DD-
MMM-YY is used. When the box is checked the windows regional setting is used. 
The current windows regional setting is displayed in this dialog box. Use the control
panel to change your date format.
Tip: Using a date format of DD-MMM-YYYY will then display a 4 digit year value. 
Also see the notes on Year 2000 dates



Year 2000

Home Budget is tested for the year 2000 and above. If the year is entered as a two digit value, and it
is less than 70, it is assume to be the 22nd century. (ie 02 = 2002 not 1902). 

You can also use a 4 digit date if you have chosen windows date format under the options dialog.



Tips and Shortcuts

Entering Dates
Reconciling Bank Statements 
Tracking Assets
Quick Sorting



Entering Dates

When using the Home Budget default date format (see the options setup)    You may enter any of the 
following formats for any date fields within Home Budget

DD-MMM-YY, example: 21-May-94
example: 21-May-01 (21-may-2001)

DDMMMYY example: 21MAY94
DDMMM example 21May
DD example 21

The remaining portions of the date, if not specified are extracted from the current date. If the year is 
entered as a two digit value, and it is less than 70, it is assume to be the 22nd century. (ie 02 = 2002 
not 1902).

Also see the notes on Year 2000 dates



Quick Sorting

By clicking on the Title Box a column will in the Account Book window or the Account Summary window
you can cause Home Budget to resort based on that column. Clicking again on the same column will 
cause a reverse sort.

Alternatively you can use the Transaction menu or the Account menu to sort. No matter which method 
you sort by the menu will have the Check mark against the column that is currently being used to sort 
against.



Reconciling Bank Statements

The easiest and fastest way to reconcile your bank Statements.

Checking accounts:
1. Goto you Checking account, and set the range back only far enough to be within the oldest Check to 

reconcile.
2. For each chequ, use the Amount or Check number and enter this into the FIND box.
3. Verify that the transaction found is indeed the same Check and if so Enter Ctrl+R to reconcile it (or 

double click reconcile column). If it is not the correct Check hit F3 to find the next occurrence of 
this Amount or Check number.

4. If the Check was not found, you missed entering it. So enter it now and immediately reconcile it 
(Ctrl+R, or double click Reconcile column).

5. Repeat steps 1-4 for each Check. Once complete the Recon Bal displayed in the Account totals 
should match the ending balance from your Bank statement.

Credit Card Statements
Use the same procedure as above, except you will only be able to search on the Amount (since no 
Check numbers are involved). Be careful to ensure you have match the correct transaction as possibly 
multiple transactions may have the same amount. Use the description or place of purchase also to be 
sure.

Tip:    Since any unreconciled transactions have an asterisk “*” displayed you can use the find function to 
search for the asterisk to locate any unreconciled transactions.



Tracking Assets
To Track your assets such as RRSPs, Stocks, investments, etc.. you can create various Asset accounts 
and record any income against these accounts.

To record income into the Asset account you can record the source account as a income Account or as 
the special account name ASSET. When you add a transaction against the asset account using the 
source account of ASSET no other real accounts are affected. On the other hand if you wish an income 
account to also reflect the income from this asset account, specify the source account as the income 
account instead. Keep in mind though if you do    use an Income account that any reports or graphs 
against budget vs Income will included this asset income which may not be part of your regular 
income/expense cash flow.

Example to Track RRSP investment:

1. If you have not already done so, create an expense account to allow you to budget for the amount 
that is to be spent on RRSP per month. Lets call it RRSP. If the amount to be put in RRSPs per 
month is $200, then set the budget amount under Budget Setup to $200 for this account.

2. Create an Asset type account that will monitor the growth of your RRSP investments, lets call it 
RRSP_Investments    Set the starting balance to the your current RRSP amount per your bank 
statement.

3. Assuming that your $200 RRSP_Investment is taken from your Checking account on the 15th of 
each month, create an autopay transaction, with the first account listed as RRSP, the source 
account would be your Checking account and the debit amount would be $200.

4. The autopayment created moves the money out from your RRSP account via your Checking account 
to purchase the RRSPs. But it did not have any affect on your RRSP_Investments asset 
account. To show the money in your RRSP_Investment account you must create another 
AutoPay transaction for the same date specifying the first account as RRSP_Investments and 
the source account as ASSETS. This amount would typically be the same, ie $200, but it does 
not have to be, in-fact if you have a service charge for example of $5.00 this can be deducted and
the transaction recorded as $195 credit to this account.

Summary: The above procedure allows for Budgeting of the RRSPs, deducts the amount from Checking 
on the 15th of each month, and records the appropriate amount in your RRSP_Investments 
asset account.

What about the interest earned?
To record any growth in the RRSPs you can record this as a transaction that you enter from 
information from statements showing interest, or if its a fixed rate you could use AutoPayments to add 
transactions of the appropriate amount to the asset account. Later any reports or Graphs against this 
asset account will give you a clear picture of how it is growing.

What about cashing an Asset?
If for example you cash an RRSP you basically repeat the steps above but this time debit the 
RRSP_Investments account against the special ASSETS source account, and record the Credit to 
your Bank or Checking account against the appropriate Income account. Or the alternative if you do 
not wish your Income account to reflect this income you could create one transaction against the 
RRSP_Investments account that moves the money directly into your Bank account.



How to Register 

You are granted use of this program for an evaluation period of 30 days. After which you must 
register with the Author. Registration costs only $15 U.S. or $20 CDN. 

Being registered means you are supporting the ShareWare concept and allows you to receive 
updates, provide wish lists for new features and that generally warm and fuzzy feeling that you did 
the right thing.

You can register online at http://www.regsoft.com (see below) or send check or Money order in U.S. 
or Canadian Funds to:

Steven Drew
216 MacEwan Valley Mews N.W.
Calgary, Alberta
Canada
T3K 3T3

Please also Include:
· Your name and Address
· Your Email address (if you have one)
· The version of Home Budget (from About Box)
· Your operating system (ie Win 95, Win NT, Win 3.1)

You will be sent a registration code (by EMAIL if you supply one or by postal mail if not) based on 
your Name that will be displayed in the About Box indicating that you are running a registered 
version of the program.

Online Registration

Note when registering online the cost is $18 (U.S.) as a small handling charge is included.

You can register using    http://www.regsoft.com (secure server) or by phone TOLL Free at 1-888-
REG-IT-80 to place your order via Voice or FAX. (International users please call 770-497-9126). 
See also the Home Budget home page at http://www.cal.shaw.wave.ca/~sdrew/hb for more 
information.

To contact the author by email: Steve.Drew@shaw.wave.ca



Copyright    Steven Drew 1998 

Steven Drew 403-295-3601
216-MacEwan Valley Mews N.W.
Calgary Alberta
Canada
T3K 3T3

Shareware $15 U.S. or $20 CDN.

See How to Register for more information.
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